
AMIRA fast Manual



https://confluence.cells.es/display/ISS/Remote+connection+to+Amira

Actions that will be done only once for your Home computer.

Download and install Workspace application from Citrix downloads.

For Windows home computer https://www.citrix.com/downloads/workspace-app/windows/

For MacOS home computer https://www.citrix.com/downloads/workspace-app/mac/

For Linux home computer https://www.citrix.com/downloads/workspace-app/linux/

Close all instances of the browser you used and reopen it again ( in order to ensure that the Citrix plugin is 

loaded )

Set up 2-Step Verification

2-SV will be needed and the users need to register their mobile phones. This is mandatory to all persons 

accessing Amira from outside Alba. Go to https://winanalysis.cells.es/manageotp to register your phones 

and setup the 2-SV.

Amira schedule

Connecting remotely from home to CELLS

https://winanalysis.cells.es/

https://nextcloud.cells.es/s/w2nwK5bxRfabZ7Y

https://www.citrix.com/downloads/workspace-app/windows/
https://www.citrix.com/downloads/workspace-app/mac/
https://www.citrix.com/downloads/workspace-app/linux/
https://winanalysis.cells.es/manageotp
https://confluence.cells.es/display/ISS/Connecting+remotely+from+home+to+CELLS?src=breadcrumbs-parent
https://winanalysis.cells.es/


1) Install the Google Authenticator app in your device (mobile phone or tablet) 

2) Then, from inside the Data Analysis desktop, go to the link https://winanalysis.cells.es/manageotp/ to enroll 

your device (link it to your account):

3) Then go back to your phone, and in Google Authenticator click on the big plus sign ( + ) and then click on

Escanear un código QR

Proceed to scan the QR code shown in the browser by pointing your phone to the PC screen:

If successful, the Google Authenticator app should show a random 6-digit number that will be changing every

minute:

4) Now go back to the browser in the winanalysis desktop, you should your device listed as enrolled, and you 

can even test the connection:

Set up 2-Step Verification

https://winanalysis.cells.es/manageotp/


Actions that should be done each time you want to connect.

1.Open a browser and go to https://workspace.cells.es

1.

2.Type your username and password, remember that your 

username usually starts with u, ie u2018093095

3.Click Log On

4.Click Detect Receiver

https://workspace.cells.es/










https://drive.google.com/drive/folders/1j-ZLuzev2VD-4OrWcn4OaJIR_61C1i-u?usp=sharing

Link for chedule Amira PC

https://drive.google.com/drive/folders/1j-ZLuzev2VD-4OrWcn4OaJIR_61C1i-u?usp=sharing


I = 𝐼0𝑒
− ׬ 𝜇𝑙 𝑥,𝑦,𝑧 𝑑𝑧1) transmission signal

2) normalization
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3) natural logarithm (has to be applied to the aligned stack)
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5) 3D reconstruction of the absorbance (using tomo3d –w off or even better tomopy gridrec):

𝑣𝑜𝑥𝑒𝑙 = − ln
𝐼

𝐼0
= 𝜇𝑙

The value of each voxel is in 1/(pixel size) and the normal unit is µm-1, if the pixel size used was for 

instance 10 nm, you need to divide the value by 0.01.

4) crop borders of the aligned ln stack symmetrically from the center of the projections (making sure that the 

borders are well cropped on all the stack projections): in ImageJ Image/Adjust/Canvas size keeping “center”)

•



After the alignment with IMOD

•



A tip that might be useful: 

sometimes our eyes are better looking at the highest absorbance in black because 
we are more used to it. For instance, people doing classical EM. So one trick would 
be to reconstruct with ART and then multiply in ImageJ all the voxels by -1 to invert 
the contrast. In this case, all the voxel values would be preserved (keeping the 
physical mean) and you just need to disregard the minus sign when doing analysis 
with Amira.



Reconstruction pre-treatment

• CHANGE OF UNIT: the value of the linear absorption 
coefficient in each voxel in the reconstruction is in 1/(pixel 
size) and the normal unit for it is µm-1, so you need to divide 
the value by 0.01 if the pixel size used was for instance 10 nm. 
You can do this in ImageJ.

• CROPPING: As Amira calculations are time consuming, we 
recommend to crop your volume as much as possible in all 
directions using the cropping function of ImageJ for X and Y 
and the “make sub-stack” tool for the Z (=number of slice).



Load DATA 1

Select your pre-treated 
DATA.tif



Load DATA 2

‘Big’ DATA needs to be loaded into 
memory.



Load DATA 3

Select ‘bounding box’ option to forgot about voxel size. Our unit volume/area/length is the ‘voxel’



Visualize volume 1

Your data are in the project window as a .tif object



Visualize volume 2

Create a bounding box and an orthoslice modules: right click on the data and select in the window 



Visualize volume 3

Create a bounding box and an orthoslice modules: right click on the data and select in the window 



Visualize volume 4

Orthoslice Main attributes: Orientation-Slice Number and Mapping Type-
Colormap.

Click on the module to visualize its attributes.



Visualize volume 5

Mapping Type-Colormap: changing the contrast manually selecting different areas of the 
contrast histogram.



Visualize volume 6

Mapping Type-Histogram: changing the contrast with different automatic selection of the 
contrast histogram.



Visualize volume 7

Orientation-Slice Number : selecting slice along a perpendicular direction (respect to the 
data)



Visualize volume 8

Orientation-Slice Number : selecting slice along a another perpendicular direction 
(respect to the data)



Visualize volume 9

Orientation-Slice Number : with 3 orthoslices modules, the 3 projections can be visualized 
altogether selecting for each orthoslice a different orientation



Visualize volume 10

Synchronizing the contrast on the 3 projections clicking on the icon ‘1’ and then drag the 
corresponding attribute on the other modules. 
You can synchronize in this way any attribute. 

1

Synchronizing attributes. 



Visualize volume 11

Hide the visualization of any modules (blue = visualization module) by de-selecting the 
blue box.

Hide the visualization of any modules



Visualize volume 12

Using orhtoslice I’m entering the volume in a direction which is clearly not perpendicular to the 
quantifoil. 

Change the visualization orientation using the ‘slice’ and ‘Resample Transformed Image’ module. 



Visualize volume 14

Create the ‘slice’ module: right click on the data.
You can find any module that doesn’t appear in the list using the searching 
option.

Change the visualization orientation using the ‘slice’ and ‘Resample Transformed Image’ module. 



Visualize volume 16

In slice, with the option ‘fit to points’, click on 3 point you want on the same plane. In this case 
the border of different holes of the quantifoil. 

Change the visualization orientation using the ‘slice’ and ‘Resample Transformed Image’ module. 



Visualize volume 14

In slice, with the option ‘fit to points’, click on 3 point you want on the same plane. In this case 
the border of different holes of the quantifoil. 

Change the visualization orientation using the ‘slice’ and ‘Resample Transformed Image’ module. 



Visualize volume 15

Now you enter through the volume in a direction which is perpendicular to the quantifoil …

Change the visualization orientation using the ‘slice’ and ‘Resample Transformed Image’ module. 



Visualize volume 16
To apply the transformation to the data in such a way to use 
the newly oriented data  
in the SEGMENTATION EDITOR, create the
computational module ¨Resample Transformed Image¨ (right 
click on data and search for it). Then left click on the white 
box and connect the ¨data¨ with the your data and the 
¨reference¨ with the slice module. Finally press apply to 
obtain the data transformed. 
If you now visualize the transformed data using the 
orhtoslice module you still have the ¨right orientation¨
defined with the slice one. We have performed the 
equivalent of the re-slice transformation in ImageJ (but in a 
more efficient way!)
Computational modules are in general in RED.

Change the visualization orientation using the ‘slice’ and ‘Resample Transformed Image’ module. 



Segmentation Editor 1



Segmentation Editor 2

In image select the data you want to segment (in this case for instance the transformed one)
In label field you have the name of the segmentation you are going to perform. Select ¨ new ¨ if you  want to start a new 
one.
In display control re-adjust the histogram selection to optimize the contrast.



Segmentation Editor 3

In Materials you have to press ¨add¨ to create a new material (Material3 in this case).
In selection you can add (+) or remove (-) the selection to/from the selected material. 
The option ¨Volume¨ or ¨Current slice¨ allows you perform this operation considering  all the selected pixels in the volume 
or in just 1 slice (the one you are visualizing on the right).
Use the rubber to remove pixels form the selection (again use ¨Volume¨ or ¨Current slice¨ options ).



Segmentation Editor 4

Use the tools in Selection to create it, i.e. to select the pixels you want to assign to some material.
Use the tools in the right upper side to modify both the 2D and the 3D visualization of the DATA.

We will never use the Exterior and the Inside materials: don`t add or remove pixels from them, i.e. don’t select them! 



Semi-manual segmentation of a 
mitochondrion1

CREATE the rough Selection:
1) Zoom on the mitochondrion. 
2) Select the Brush tool and its dimension



Semi-manual selection of a mitochondrion2

CREATE the rough Selection:
3) Paint the pixels using the right button of the mouse. The selection can be fast and not precise, approximate it por

exceso. You can remove very wrong pixels using the control key.
4) Do it every 5 slices.



Semi-manual selection of a mitochondrion3

CREATE the rough Selection:
5) In Selection select Interpolation: it will extend the selection through all the slices 

OBS: the interpolation could miss some slices: ADD them manually! (Look for them in the 2D viewer).



Semi-manual selection of a mitochondrion3

CREATE the rough Selection:
4) Take a look to it in the 3D viewer. Your selection are the pixel in the red.
5) Add them to the selected materials (Material3 in this case) using +. Be sure that the Volume option is selected.
6) The selected pixels will disappear. To see them again select the option 3D in the selected material .
OBS: the interpolation could miss some slices: ADD them manually! (Look for them in the 2D viewer).



Semi-manual selection of a mitochondrion4

CREATE the refined Selection/Material for instance the mitochondrial cristae:
1) Use the magic wand tool with the All Slices option and Same Material only.
2) Using the threshold of the histogram to the adjust the selection in violet. Optimize it, i.e. refine the shape of the 

mitochondrion.
3) Add them to the selected materials (Material3 in this case) using +



Semi-manual selection of a mitochondrion4

CREATE the refined Selection/Material:
4) Create a new material (Material4) with add and add the new selection to it with +
5) Again selected pixels will disappear in the 3D viewer. To see them again select the option 3D in the selected material.
The refined selection (in blue) will appear, both with the rough one (in red) as far the 3D option is selected for material 3.
The blue volume should be smaller than the red one. Can you re-use the same thresholds with the magic wand on another 
mito? In general no, but sometimes yes. In principle this is the appropriate choice….



Automatic selection of a lipid droplet 

If the object is well in contrast respect to the background (different intensity, i.e. absorption coefficient)  respect with the
surroundings) you can directly select it well with the magic wand.
Just define the thresholds appropriately.
In the figure I have already created a second particle.



Ending the segmentation

You should check the quality of your segmentation looking also to the other planes.



Label Analysis1

Create the computational module ¨Label Analysis¨ (right click on the Labels and search for it). 



Right click on the white square and connect ¨Intensity Image ¨ to the DATA (the transformed one of course.

Label Analysis2



Then click apply. Wait.

Label Analysis 3



Label Analysis 4

The result of the Label Analysis will appear both as a new object connected the Label 
Analysis and as a TAB on the right with the numerical results. 



Label Analysis 5

You can change the computed quantities and define a new measurements group 
clicking on … in Measures



Label Analysis 6

Create a NewGroup unidng + and add the quantities you want to compute.
Click OK.
The Histogram Peak is an interesting value: is the Mode
as we will see in the following slides, the intensity distribution (i.e. the values of the 
linear absorption coefficient) is not Gaussian. So that the mean value is not the most 



Label Analysis7

The Histogram Peak is an interesting value: is the Mode
as we will see in the following slides, the intensity distribution (i.e. the values of the 
linear absorption coefficient) is not Gaussian. So that the mean value is not the most 
probable value, i.e, the mean ≠ mode. 





Arithmetic module 

To create a material from the segmentation we have performed we can use the
Arithmetic module (right click on the data for it). 



Arithmetic module 

Right click on the white box and connect
Input A with the DATA and Input B with the labels file. 



Arithmetic module 

Right click on the white box and connect
Input A with the DATA and Input B with the labels file. 



Arithmetic module 

Set the Expression as A*(B==3). 
This will multiply the data by the 
selection we have created
in the segmentation editor 
corresponding to the Label=3 
which is Material 4 (the Nucleus). 

It is always Material number = 
Label number +1.

With Apply and the DATA ¨Result¨
will be created. General operation 
can be performed.  

Nucleus
Mitochondria



Mitochondria

Create the others materials using the arithmetic module

Arithmetic module 



With Apply and the DATA ¨Result¨ will be 
created.
General operation can be performed

Arithmetic module 

You can take a look to it in 3D using 
the Volume rendering module (right 
click on result DATA and create it). 



Volume rendering

Deselect the blue box in any orthoslice or slice module to remove the stack visualization.  



Create the others materials using the arithmetic module and visualize them using 3 
different Volume rendering modules. 

Volume rendering



You can also manage the color option.
Double click inside colormap.
Here in red is the nucleus
In Blue the mitochondria
In yellow the vesicles

Volume rendering



The module Volren can also be used. It seems to use much less memory…

Volume rendering



Volume rendering

You can take a snapshot of the viewer and create a high resolution figure in many 
different formats.



The Results can be exported: file export data as (.mrc 3d tiff .tif for instance) and be opened, visualized and analyzed using 
another software.

Volume rendering



Volume rendering: fast way

You can directly create a Volume Rendering module from  the labels without using the 
‘arithmetic’ and create 3 separate results. 
But in this case just different colors can be used (1 per label = material).
Also, you cannot export them. 



You can also take a look to the actual 
distribution of the pixels values using the 
Histogram module.

Histogram1



Histogram2

To change the default settings (the axis in particular, to optimize the visualization) click on 
edit axis.



Volume rendering: fast way2a

You can create in the segmentation 
editor a new material (with “Add”) and 
then you can transfer all the voxels from 
a material to the new one using the 
corresponding “select” button and then 
the “+”. 
Pay attention to select with the mouse 
the new material to transfer the pixels to 
it (in figure for instance I’m moving the 
voxels  from material5 to material7).



Volume rendering: fast way2b

If you do it for all the mitochondria, at the end you will end with a single (big) material 
containing all the mitochondria and you can give to it the color you want in the project 
editor. This is a smart way to have all the same kind of object with the same color without 
creating them one by one using the arithmetic module (which is still needed if you want to 
export them). You will have to use arithmetic just once!
NOTE that in this way you will loose the other materials so that if you are interested in the 
statistics on the single object (in this case mitochondrion) you have to save it as an another 
project (Save Project as in File).



Volume rendering: filters

You can improve the appearance of you 
material using a filter. Right click on the 
“Result”
and search for “filter”: you have a lot of 
them. Here I used the Gaussian Filter 
module for example, with those 
parameters…

Our experience is that the “Non Local 
Mean” (to preserve average values) and
is good one.

…and I got this: “pixelling” of the object 
surface is removed.



Apply the same segmentation to different DATA

It has sense of course only if your DATA are the same, but with different numbers.
Typically you would like to re-apply the same segmentation you performed on the linear 
absorption coefficient obtained using ART on the volume you get using SIRT with the 
transmission (or vice versa).
We have to assume that the 2 reconstructions obtained with 2 different algorithms are the 
same in terms of morphology. 
Then:
1- Load your amira project containing the segmentation.
2- In the project, open new data from file. I called it like the original one with “32b”
3- If you have applied some transformation on your data BEFORE creating the materials in the 
segmentation editor, we have to apply the same transformation to our new data set.



Apply the same segmentation to different DATA



Apply the same segmentation to different DATA

In the new data create a module “slice”.
Activate the plane definition option 

In this case we want to re-apply the transformation defined by the module “slice”. 



Apply the same segmentation to different DATA

Create another slice module and then to apply exactly the same orientation.
Insert the same parameters you had in the first slice module, i.e. the one you used on the original DATA set. If you 
move the same “slice” module from one to the other data you will lost in any case the “plane parameters” (write 
down them somewhere at the real beginning, just in case).



Apply the same segmentation to different DATA

Now the new DATA set has the right orientation and you can re-apply the transformation using the 
“Resample Transformed Image” module.



Apply the same segmentation to different DATA

Then left click on the white box and connect the ¨data¨ with the your data and the ¨reference¨ with the slice 
module. Finally press apply to obtain the data transformed. 



Apply the same segmentation to different DATA

If you now visualize the transformed data using the orhtoslice module you still have the ¨right orientation¨ defined 
with the slice one. 
Computational modules are in general in RED.



Left click on the white square, the DATA is your already existing label field, the “Intensity image” is the new 
transformed DATA on which you want to apply the old label field.

Apply the same segmentation to different DATA



If you want to produce a simple video with a visualization of time-dependent data with a fixed view, you

will only need the MovieMaker.

More complex animations or series of animations can be set up with the Animation Director module. 

With the Animation Director, you can combine and synchronize time animations, camera rotations, and 

movements of 2D slices etc., as well as switch modules on or off. 

Basically, all parameters of the active modules can be changed. Evencomplex animations, like time 

animation combined with rotation of the view or a moving camera position can be accomplished by using

the Camera Orbit or the Camera Path modules. 

After you have finalized the choreography of your animation in the Animation Director, the result can be 

saved in form of an MPEG-1 video or as a sequence of single image files. 

The Animation Director module is activated or deactivated by pressing the Animation button in the

toolbar or by selecting Window > Animation

Animations and Movies



Animations and Movies

There are different perspectives when it comes to animation: 

Animate data object

Animate camera

Animate visualization property: Animate orthoslice, clipping plan, or volume rendering transparency



Animations and Movies

1. Control bar

2. Animation Director 

toolbar

3. Event list

4. Timeline

5. Master Time Slider

6. “Movie Creation” 

Menu

7. More Options” Menu

1

2
3

45

6 7

Time Management: In order to define the length of your

animation storyboard, you can open the “More Options” 

menu (7.) and set parameters such as the start and end

time and number of frames per second.

A new widget becomes visible, hosting the Animation Director’s

user interface. 

Clicking on the stopwatch button in the Properties of a module 

creates a new keyframe in the Animation Director timeline and 

the event is listed in the left panel of the user interface. If you

hold the mouse cursor above the small orange diamond symbol  

in the timeline panel, it activate a small input field where you can 

adjust the time and the accompanying value for the port that it’s

associated with.

In order to adjust the schedule, you can simply drag the

diamond icon to the desired position on the timeline.



Moving the Ortho Slice: plane up and down to show what the data looks like. 

The Ortho Slice module has a port called Slice Number . If you change the value of that slider, you see the

plane move in the viewer.

Animating an Ortho Slice module

Like the other widgets, this widget is also dockable and you can place it at a convenient position

within the Amira user interface. After activating the Animation Director  by clicking on the related

button in the toolbar, all ports of the currently available modules that can be animated are extended by

an additional button representing a stopwatch .

From the toolbar, click on the Animation Director  button.

A new widget becomes visible hosting the Animation Director user interface.



We can now animate the Ortho Slice position. We do this by clicking on the stopwatch button of the

Slice Number port in order to schedule the start event:

Clicking on the stopwatch button creates a new keyframe in the Animation Director timeline and the event is

listed in the left panel of the user interface.

If you hold the mouse cursor above the smal orange diamond symbol in the timeline panel, this will activate a

small input field where you can adjust the time and the accompanying value for the port with which it is

associated. In order to adjust the schedule, you can simply drag the diamond icon to the desired position on the

timeline.

With this operation, we have defined the beginning of the animation of the slice position. Next we want to define

the time where the animation should end. To do this, we drag the master time slider to the desired time on the

timeline, e.g., to 00:04.000, which means 4 seconds. As a next step, we set the slice position of the Ortho Slice

module by either setting the Slice Number port in the properties of the module or by positioning the slice

interactively in the viewer window. Using either method, set the value of the Slice Number port should be set to

131. After you click the stopwatch button again, the keyframe is created in the timeline.

You can test your first animation

https://www.thermofisher.com/software-em-3d-vis/xtra-library/xtras/how-to-start-with-the-animation-director



https://www.thermofisher.com/software-em-3d-vis/xtra-library/xtras/how-to-animate-the-appearance-of-objects-with-the-animation-director

How to Animate the Appearance of Objects with the Animation Director

We do this by selecting Volume Rendering and  clicking on the stopwatch button

Select visibility 0

A new keyframe in the Animation Director  timeline and the event is listed in the left panel of the user interface

If you hold the mouse cursor above the smal orange diamond symbol in the timeline panel, this will activate

a small input field where you can adjust the time and the accompanying value for the port with which it is

associated.

In order to adjust the schedule, you can simply drag the diamond icon to the desired position on the

timeline.



https://www.thermofisher.com/software-em-3d-vis/xtra-library/xtras/how-to-animate-the-appearance-of-objects-with-the-animation-director

How to Animate the Appearance of Objects with the Animation Director

Press for adding a new  keyframe: new keyframe is created in the timeline

Double click in the Orange diamond and selected ON and the volumen rendering would be now visible.

You can test your animation clicking



To create a movie from an animation defined with the Animation Director, simply click on the

Movie Creation button of the Animation Director panel. The following panel will appear:

Creating a movie from an animated demonstration

This module is already pre-configured to create a movie that respects the animation settings (duration, 

frame rate, filename...) that are defined by the Animation Director  module. However, you can adjust

these parameters, if needed. Just click on the Create Movie button to generate the movie.



Right click in empty space, choose

Create Object ->Camera Path-> Create

Movie Maker using Camera Path



Right click in empty space, choose

Create Object ->Camera Path-> Create

Open camera path editor,

Click camera Path editor



A separate camera path edit/view window will open.

Click camera Path editor.

Change view position in main window, then click “add” button to add a keyframe. 



Change zoom level in main window, then click “add” button to add a keyframe.

In the small window you can move the

visualization camera of your volume



Check your movie



Click on empty space and select -> Favorites -> Movie Maker



Select your output file and the file format-> APPLY  



AMIRA-AVIZO learning center on YouTube

https://www.youtube.com/playlist?list=PLoxdPzacxPYjDVMD4tPCaVbuQjxYizr_g

For many more tutorials…..

For example this is an interesting one (with some instruction to separated objects that 
cannot be separate by a simple threshold):
https://www.youtube.com/watch?v=YsOc5R80MFM


